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FINALTERM EXAMINATION
Spring 2010
CS302- Digital Logic Design
Time: 90 min
Marks: 58
Question No: 1 (Marks: 1) - Please choose one
A 8-bit serial in / parallel out shift register contains the value “8”, clock signal(s)
will be required to shift the value completely out of the register.
> 1
> 2
> 4
> 8
Question No: 2 (Marks: 1) - Please choose one
A frequency counter

» Counts pulse width
» Counts no. of clock pulses in 1 second
» Counts high and low range of given clock pulse
» None of given options
Question No: 3 (Marks: 1) - Please choose one
In a sequential circuit the next state is determined by and
» State variable, current state
» Current state, flip-flop output
» Current state and external input
» Input and clock signal applied
Question No: 4 (Marks:1). - Please choose one
The divide-by-60 counter in digital clock is implemented by using two cascading
counters:
» Mod-6, Mod-10
» Mod-50, Mod-10
» Mod-10, Mod-50
» Mod-50, Mod-6
Question No: 5 (Marks: 1) - Please choose one
In NOR 'gate based S-R latch if both S and R inputs are set to logic 0, the previous output
state is maintained.
» True
» False
Question No: 6 (Marks: 1) - Please choose one
Flip flops are also called
» Bi-stable dualvibrators
» Bi-stable transformer
» Bi-stable multivibrators
» Bi-stable singlevibrators
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Question No: 7 (Marks: 1) - Please choose one
The minimum time for which the input signal has to be maintained at the input of flip-
flop is called of the flip-flop.
» Set-up time
» Hold time
» Pulse Interval time
» Pulse Stability time (PST)
Question No: 8 (Marks: 1) - Please choose one
74HC163 has two enable input pins which are and
» ENP, ENT
» ENI, ENC
» ENP, ENC
» ENT, ENI
Question No: 9 (Marks: 1) - Please choose one
is said to occur when multiple internal variables change due to change in
one input variable
» Clock Skew
» Race condition
» Hold delay
» Hold and Wait
Question No: 10 (Marks: 1) - Please choose one
Given the state diagram of an up/down counter, we can find
» The next state of a given present state
» The previous state of/a given present state
» Both the next and previous states of a given state
» The state diagram shows only the inputs/outputs of a given states
Question No: 11 (Marks: 1) - Please choose one
The input overrides.the input
» Asynchronous, synchronous
» Synchroneus, asynchronous
» Preset input (PRE), Clear.input (CLR)
» Clear.input (CLR), Preset input (PRE)
Question'No: 12, (Marks: 1) - Please choose one

A logic cifcuit with an output A= AB C +AB  consists of
» two AND gates, two OR gates, two inverters
» three AND gates, two OR gates, one inverter
» two AND gates, one OR gate, two inverters
» two AND gates, one OR gate

Question No: 13 (Marks: 1) - Please choose one

A decade counter is
» Mod-3 counter
» Mod-5 counter
» Mod-8 counter
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» Mod-10 counter
Question No: 14 (Marks: 1) - Please choose one
In asynchronous transmission when the transmission line is idle,
» It is set to logic low
» It is set to logic high
» Remains in previous state
p State of transmission line is not used to start transmission
Question No: 15 (Marks: 1) - Please choose one
A Nibble consists of bits
> 2
> 4
> 8
» 16
Question No: 16 (Marks: 1) - Please choose one
The output of this circuit is always
+oo

D) -
Y
> 1

>0
> A
p A
Question No: 17 ( Marks:4) - Please choose one
Excess-8 code assigns to “-8"
> 1110
» 1100
» 1000
» 0000
Question No: 18 ( Marks: 1) - Please choose one
The voltage gain of the Inverting Amplifier is given by the relation
» Vou! Vin =- Rt/ R;
» Voit/ Rt =- Vin/ R
» Rt/ Vin=- Ri/ Vou
» Rt/ Vin= Ri/Vou
Question No: 19 (Marks: 1) - Please choose one
LUT is acronym for
» Look Up Table
» Local User Terminal
» Least Upper Time Period
» None of given options
Question No: 20 (Marks: 1) - Please choose one
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DRAM stands for
» Dynamic RAM
» Data RAM
» Demoduler RAM
» None of given options
Question No: 21  (Marks: 1) - Please choose one
The three fundamental gates are
» AND, NAND, XOR
» OR, AND, NAND
» NOT, NOR, XOR
» NOT, OR, AND
Question No: 22 (Marks: 1) - Please choose one

D — Q

CLK —¢ — Q

Which of the following statement is true regarding above block diagram ?
» Triggering takes place on the negative-going edge of the CLK pulse
» Triggering takes place on the positive-going edge of the CLK pulse
» Triggering can take place anytime.during the HIGH level of the CLK waveform
» Triggering can take place anytime during the LOW level of the CLK waveform
Question No: 23 (Marks: 1) - Please choose one
The total amount of memory that is.supparted by any digital system depends
upon
» The organization of-memory
» The structure of memory
» The size of decoding. unit
» The size of.the address. bus of the microprocessor
Question No: 24 (Marks: 1)) -Please choose one
The expression F=A+B+C describes the operation of three bits Gate.
» OR
» AND
> NOT
» NAND
Question No: 25 (Marks: 1) - Please choose one
Stack is an acronym for
» FIFO memory
» LIFO memory
» Flash Memory
» Bust Flash Memory
Question No: 26 (Marks: 1) - Please choose one
Addition of two octal numbers “36 and “71” results in
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> 213

> 123

» 127

» 345
Question No: 27 ( Marks: 2)
Define quantization process.

Question No: 28 ( Marks: 2)

Explain the difference between 1-to-4 Demultiplexer and 2<to-4 Binary Decoder?

Question No: 29 ( Marks: 2)

A general Sequential circuit consists of a.combinational.€ircuit and a memory
element. How this memory glement is.implemented

Question No: 30 .«(Marks: 2)

Suppose a2 bit up-counter, having states “A, B, C, D”. Write down GOTO
statements to shaw how present states change to next states.

Question No: 31 ( Marks: 3)

Name three Operations that can be performed on FLASH Memory
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Question No: 32 ( Marks: 3)

Explain Rotate Right Operation of shift register with the help of diagram.
Question No: 33 ( Marks: 3)

You are given the block diagram of 74HC190 integrated circuit up/down-Counter,
explain the function of labeled inputs/outputs.

DIU — 74HC190

Draw the.state diagram of 3-bit up-down counter, use an external input X, when X
sets to lagic4, the counter counts downwards, otherwise upward.

MAX/MIN

Question No: 34 (Marks: 5)

Question' No:35 ( Marks: 5)

Differentiate between synchronous and asynchronous RAM.

Question No: 36 ( Marks: 5)

Explain Memory Select or Enable Signals
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FINALTERM EXAMINATION
Spring 2010
CS302- Digital Logic Design (Session - 4)

Time: 90 min
Marks: 58
Question No: 1 (Marks: 1) - Please choose one
The ANSI/IEEE Standard 754 defines a Single-Precision Floating Point
format for binary numbers.
» 8-bit
» 16-bit
» 32-bit
» 64-bit
Question No: 2 (Marks: 1) - Please choose one
The decimal “17” in BCD will be represented as
» 11101
» 11011
» 10111
» 11110
Question No: 3 (Marks: 1) - Please choose one
The basic building block for a.logical circuit is
» A Flip-Flop
» A Logical Gate
» An Adder
» None of given options
Question No: 4 (Marks: 1)) -Please choose one
The output of the expressioniF=A.B.C will be Logic when A=1, B=0, C=1.
» Undefined
» One
» Zero

» No Output as input is invalid.

Question No: 5 (Marks: 1) - Please choose one
is.invalid number of cells in a single group formed by the adjacent cells in K-

map

> 2

» 8

» 12

» 16
Question No: 6 (Marks: 1) - Please choose one
The PROM consists of a fixed non-programmable Gate array configured
as a decoder.

» AND
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» OR
» NOT
» XOR
Question No: 7 (Marks: 1) - Please choose one
is one of the examples of synchronous inputs.
» J-K input
» EN input
» Preset input (PRE)
» Clear Input (CLR)
Question No: 8 (Marks: 1) - Please choose one
is one of the examples of asynchronous inputs.
» J-K input
» S-R input
» D input
» Clear Input (CLR)
Question No: 9 (Marks: 1) - Please choose one
The input overrides the input
» Asynchronous, synchronous
» Synchronous, asynchronous
» Preset input (PRE), Clear input (CLR)
» Clear input (CLR), Preset input (PRE)
Question No: 10 (Marks: 1) - Please choose one
occurs when the same clock signal arrives at.different times at different
clock inputs due to propagation delay.
» Race condition
» Clock Skew
» Ripple Effect
» None of given options
Question No: 11 ( Marks: 1) - Please choose one
Consider an up/down counterthat counts between 0 and 15, if external input(X) is “0”
the counter counts upward (0000.to 1111) and if external input (X) is “1” the counter
counts downward (1111 to 0000), now suppose that the present state is “1100” and X=1,
the next state of the counter will be
» 0000
> 1104
> 1011
> 1111
Question No: 12 (Marks: 1) - Please choose one
In a state diagram, the transition from a current state to the next state is determined by
» Current state and the inputs
» Current state and outputs
» Previous state and inputs
» Previous state and outputs
Question No: 13 (Marks: 1) - Please choose one
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is used to minimize the possible no. of states of a circuit.
» State assignment

» State reduction
» Next state table
» State diagram

Question No: 14 (Marks: 1) - Please choose one

is used to simplify the circuit that determines the next state.
» State diagram

» Next state table
» State reduction
» State assignment
Question No: 15 (Marks: 1)
The best state assignment tends to

» Maximizes the number of state variables that don’t change.in a group of related
states

- Please choose one

» Minimizes the number of state variables that den®t change in agroup of
related states

» Minimize the equivalent states
» None of given options

Question No: 16 (Marks: 1) - Please choose one

The output of this circuit is always
+ce

D) -
Y
> 1
>0

> A
>

Question No: 17 (/Marks: 1)) < Please choose one
A 8-bit serial in'/ parallel'out shift register contains the value “8”

will be required to shift'the value completely out of the register.
> 1

> 2
> 4
> 8

Question No: 18 (Marks: 1) - Please choose one

5-bit Johnson counter sequences through states
» 7

» 10
» 32
» 25
Question No: 19 (Marks: 1)

, clock signal(s)

- Please choose one
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Assume that a 4-bit serial in/serial out shift register is initially clear. We wish to
store the nibble 1100. What will be the 4-bit pattern after the second clock pulse?
(Right-most bit first.)
» 1100
» 0011
» 0000
> 1111
Question No: 20 (Marks: 1) - Please choose one
The address from which the data is read, is provided by
» Depends on circuitry
» None of given options
» RAM
» Microprocessor
Question No: 21 (Marks: 1) - Please choose one
FIFO is an acronym for
» First In, First Out
» Fly in, Fly Out
» Fast in, Fast Out
» None of given options
Question No: 22 (Marks: 1) - Please choose one
LUT is acronym for
» Look Up Table
» Local User Terminal
» Least Upper Time Period
» None of given options
Question No: 23 (Marks;:"1) - Please choose one
The voltage gain of the Inverting Amplifier is given by the relation
» Vout/ Vin = - Rf/ R;
» Vout/ Rt =- Vin/ Rj
» Rt/ Vin = #Ril Vout
» Rt/ Vin = Ril Vout
Question No: 24/ (Marks: 1) - Please choose one
of a D/A converter is determined by comparing the actual output of a D/A
converter with the expected output.
» Resolution
» Accuracy
» Quantization
» Missing Code

Question No: 25 (Marks: 1) - Please choose
one
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Above is the circuit diagram of
» Asynchronous up-counter
» Asynchronous down-counter
» Synchronous up-counter
» Synchronous down-counter
Question No: 26 (Marks: 1) - Please choose one
The sequence of states that are implemented by a n-bit Johnson counter is
» n+2 (n plus 2)
» 2n (n multiplied by 2)
» 2" (2 raise to power n)
» n? (nraise to power 2)
Question No: 27 ( Marks: 2)
Draw the Truth-Table of NOR based S-R Latch

input output
S R Q1+
0 0 Qr
0 1 0
1 0 1
1 1 INVALID

Question No: 28 ( Marks: 2)

Two state assignments are given in the table below. Identify which state assignment
is best and why?

States State assignment 1 State assignment 2

A 00 00

Any problem regarding MCS feel free to mail me we try our best level to help you in
every steps...

fantasy.fear@gmail.com



Tabish Ali Raza Uzair Husnain

eagle_eye) strange_stranger
B 01 01
C 11 10
D 10 11
Ans:

State assignment 2 is best assignment... it Minimizes the number of state variables that
don’t change in a group of related states
. Question No: 29 ( Marks: 2)
Write down at least two functions of a register.
Ans:
1.  Registers are operating as a coherent unit to hold and generate’data.
2. registers functions also include configuration and start-up of certain
features, especially during initialization, bufferstorage e.g. video memory for
graphics cards, input/output (1/0) of different kinds;

Question No: 30 ( Marks: 2)

Define quantization process.

Ans:

The process by which we can convert an analogue signal into digital signal (code) is
known as quantization process.

Question No: 31 ( Marks: 3)
How can we calculate the frequency of an unknown signal?

Ans:

The frequency of‘a particular‘event is‘accomplished by counting the number of times that
event occurs within a specific time interval, then dividing the count by the length of the
time interval

Question No: 32 ( Marks: 3)

Given the following statement used in PLD programming:
Y PIN 23 ISTYPE ‘com’;
Explain what does this statement mean?

Ans:
The Y variable is a ‘Combinational” output available directly from the AND-OR gate
array output. The active-low or active-high output of the Registered Mode can also be
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specified in the declaration statement

Question No: 33 ( Marks: 3)
Explain dynamic RAM in your own words.
Ans:
Dram use latch to store a single bit of information. The main drawback of it id the
discharge of capacitor over a period of time. Here four gates are used in making a single
latch. In terms of transistors, 4 to 6 transistors are required to implement'a single storage
cell. In order to build memories with higher densities, a single transistor is used to store a
binary value. A single transistor can not store a binary value however'it is used to charge
and discharge a capacitor. The capacitor can not retain the charge, therefore it has to be
periodically charged
Through a refresh cycle.

Question No: 34 (Marks: 5)
You are given the Next-state table of a moor machine, using.this information draw
the state diagram of the machine.

Present State Next State

Q2 Q: Qo Q- Q1 Qo

0 1 1 1 1 1
1 1 0 0 1

0 0 1 0 1 0

0 1 0 1 0 0

1 0 0 1 1 0

1 1 0 0 1 1

Question No: 35 _«( Marks: 5)

Explain Memary Select or Enable Signals
Memory Select or Enable Signal:

There are'more than.one memory chips to store program
Informationin daily use computers. read or write operation is carried out on a single
addressable location instantaneously .

The unique location is accessed in one of the several memory chips, so single memory
chips is selected before a read or write operation can be carried out. All memory chips
have a chip enable or chip select signal which has to be activated before the memory can
be accessed.

Question No: 36 (Marks: 5)

Performance characteristics of D/A converters are determined by five parameters. Name
them.
Ans:
Performances characteristics of D/A converters are determined by five parameters
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are as follow:
1. Accuracy
2 Setting time
3 Monotonicity
4, Linearity
5 Resolution
FINALTERM EXAMINATION

Spring 2010
CS302- Digital Logic Design (Session - 1)

Time: 90 min
arks: 58
Question No: 1 (Marks: 1) - Please choose one
"A+B=B+A" is
» Demorgan’s Law
» Distributive Law
» Commutative Law
» Associative Law
Question No: 2 (Marks: 1) - Please.choose one
The diagram given below represents
D
B
2t

-
—1 )
» Demorgans law
» ASssociative law
» Product of sum form
» Sum-ofproduct form

Question No: 3 (Marks: 1) - Please choose one
Following is standard POS expression

(A+B+C+D)A+B+C+Di(A+B+C+D)A+B+C+D)A+B+C+D)
» True
» False

Question No: 4 (Marks: 1) - Please choose one

An alternate method of implementing Comparators which allows the Comparators to be
easily cascaded without the need for extra logic gates is

Any problem regarding MCS feel free to mail me we try our best level to help you in
every steps...

fantasy.fear@gmail.com




Tabish Ali Raza Uzair Husnain
eagle_eye) strange_stranger

» Using a single comparator
» Using Iterative Circuit based Comparators
» Connecting comparators in vertical hierarchy
» Extra logic gates are always required.
Question No: 5 (Marks: 1) - Please choose one
Demultiplexer is also called
» Data selector
» Data router
» Data distributor
» Data encoder
Question No: 6 (Marks: 1) - Please choose one
The operation of J-K flip-flop is similar to that of the SR flip-flop exeept that the J-K
flip-flop
» Doesn’t have an invalid state
» Sets to clear when bothJ=0and K=0
» It does not show transition on change in pulse
» It does not accept asynchronous inputs
Question No: 7 (Marks: 1) - Please choose one
A positive edge-triggered flip-flop changes its state when
» Low-to-high transition of clock
» High-to-low transition of clock
» Enable input (EN) is set
» Preset input (PRE) is set
Question No: 8 (Marks: 1) - Please choose one
A flip-flop is connected to +5 voltsand it draws 5 mA of current during its operation, the
power dissipation of the flip-flop is
> 10 mW
» 25 mW
» 64 mW
> 1024
Question No: 9 . ( Marks: 1 )"..«Please choose one
counters as the name indicates are not triggered simultaneously.
» Asynchronous
» Synchronous
» Positive-Edge triggered
» Negative-Edge triggered
Question No: 10 (Marks: 1) - Please choose one
74HC163 has two enable input pins which are and
» ENP, ENT
» ENI, ENC
» ENP, ENC
» ENT, ENI
Question No: 11 (Marks: 1) - Please choose one
The divide-by-60 counter in digital clock is implemented by using two cascading
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counters:
» Mod-6, Mod-10
» Mod-50, Mod-10
» Mod-10, Mod-50
» Mod-50, Mod-6
Question No: 12 (Marks: 1) - Please choose one
In a state diagram, the transition from a current state to the next state is determined by
» Current state and the inputs
» Current state and outputs
» Previous state and inputs
» Previous state and outputs
Question No: 13 (Marks: 1) - Please choose one
A synchronous decade counter will have flip-flops
>3
> 4
> 7
> 10
Question No: 14 (Marks: 1) - Please choose one
is used to minimize the possible no. of states of a circuit.
» State assignment
» State reduction
» Next state table
» State diagram
Question No: 15 ( Marks:'1) . - Please choose one
A multiplexer with a register circuit.converts
» Serial data to parallel
» Parallel data to serial
» Serial data to serial
» Parallel data to parallel

Question No: 16. (‘Marks: 1)...= Please choose one
The alternate solution fora demultiplexer-register combination circuit is
» Parallel in / Serial out shift register
» Serial in / Parallel out shift register
» Parallelin/ Parallel out shift register
» Serial in / Serial Out shift register
Question No: 17 (Marks: 1) - Please choose one
A GAL is essentially a .
» Non-reprogrammable PAL
» PAL that is programmed only by the manufacturer
» Very large PAL
» Reprogrammable PAL
Question No: 18 (Marks: 1) - Please choose one
The output of this circuit is always
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+Vce

OL-
Y
> 1
>0

> A
>

Question No: 19 (Marks: 1) - Please choose one
DRAM stands for

» Dynamic RAM

» Data RAM

» Demoduler RAM

» None of given options

Question No: 20 (Marks: 1) - Please choose one
in , all the columns in the.same row are either read or written.

» Sequential Access
» MOS Access
» FAST Mode Page Access
» None of given options
Question No: 21  ( Marks:'1 )" - Please choose one
FIFO is an acronym for
» First In,First Out
» Fly in, Fly Qut
» Fast in, Fast Out
» Nope of given options
Question.No:22 (Marks: 1) - Please choose one
In order to synchronize two devices that consume and produce data at different rates, we
can use
» Read Only Memory
» Fist In First Out Memory
» Flash Memory
» Fast Page Access Mode Memory
Question No: 23 (Marks: 1) - Please choose one
A frequency counter
» Counts pulse width
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» Counts no. of clock pulses in 1 second
» Counts high and low range of given clock pulse
» None of given options

Question No: 24 (Marks: 1) - Please choose one
The sequence of states that are implemented by a n-bit Johnson counter is
» n+2 (n plus 2)
» 2n (n multiplied by 2)
» 2" (2 raise to power n)
» n? (nraise to power 2)
Question No: 25 (Marks: 1) - Please choose one
Stack is an acronym for
» FIFO memory
» LIFO memory
» Flash Memory
» Bust Flash Memory
Question No: 26 (Marks: 1) - Please choose one
The 4-bit 2°s complement representation of “+5” is
» 1010
» 1110
> 1011
> 0101
Question No: 27 ( Marks:2)
Explain the erase operation in context of Flash Memory.

Question No: 28 ( Marks:2)
Explain the difference between 1-to=4 Demultiplexer and 2-to-4 Binary Decoder?

Question No: 29" ( Marks: 2)
Some of the.counters (e.g. 74HC163) are called pre-set counters. why?

Question No: 30 ( Marks: 2)
How many bytes will be there in 32 K x 8 memory?
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Question No: 31 ( Marks: 3)
Differentiate between truth table and next-state table

Question No: 32 ( Marks: 3)
Name the three types of errors Analogue to Digital converters exhibit during their
conversion operation.

Question No: 33 ( Marks: 3)
How can a serial in/parallel out register be used as a serial.in/serial out register?

Question No: 34 (Marks: 5)
Explain the implementationsef First In First Qut (FIFQ) Memory by using RAM.

Question No: 35" ( Marks: 5)
Explain memory read operation with the help of an example
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Question No: 36 ( Marks: 5)
Explain the next-state table with the help of a table for any sequential circuit
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